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SUMMARY

This protocol provides instructions to acquire high-quality cellular contractility
data from adult, neonatal, and human induced pluripotent stem cell-derived car-
diomyocytes. Contractility parameters are key to unravel mechanisms underlying
cardiac pathologies, yet difficulties in acquiring data can compromise measure-
ment accuracy and reproducibility. We provide optimized steps for microscope
and camera setup, as well as cellular selection criteria for different cardiomyo-
cyte cell types, aiming to obtain robust and reliable data. Moreover, we use
CONTRACTIONWAVE software to analyze and show the optimized results.
For complete details on the use and execution of this profile, please refer to
Scalzo et al. (2021).

BEFORE YOU BEGIN

This optimized protocol includes methods for different types of cardiomyocytes (adult, neonatal,

and human induced pluripotent stem cells), each with their own experimental particularities. The

steps were written as a guide for both beginners and expert researchers to acquire robust and repro-

ducible cellular contractility data.

Cardiomyocyte cellular dissociation

The protocol described below has been tested using freshly dissociated adult ventricular myocytes

(adult-CM) as well as cultured neonatal (neonatal-CM) and human induced pluripotent stem cell-

derived cardiomyocytes (hiPSC-CM). The studies with both adult and neonatal animals were con-

ducted in accordance with the National Institutes of Health (NIH)Guide for the Care and Use of Lab-

oratory Animals, and approved by the Institutional Animal Care and Use Committee at UFMG (CEUA

138/2018). As each laboratory likely follows its protocols, the methods cited below are for reference

only: for freshly adult cardiomyocytes (Guatimosim et al., 2001; Tian et al., 2020), for neonatal car-

diomyocytes (Guatimosim et al., 2008), for human induced pluripotent stem cell-derived cardiomyo-

cytes (Cruvinel et al., 2020).

Cell imaging setup optimization

Kohler illumination

Timing: 10–15 min
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For robust image acquisition and analysis, the microscope and camera should provide uniform illu-

mination, reasonable contrast, and clear delimitation of the cell boundary. These criteria can be

satisfied by setting up the microscope for brightfield examination and Köhler illumination (set up in-

structions can be usually found in the microscope manual).

Note: Even modern microscopes can have compromised image quality due to issues with the

light source. An optimal cell illumination should be glare-free and dispersed uniformly in the

field of view.

Microscope cleanliness

Timing: 10–30 min

For high-quality cell imaging, it is important to certify that no dust or dirt appears in the captured

images, as it can substantially affect the contractility analysis. Therefore, dirt along the optical

pathway or on the camera lens needs to be removed. There are few steps to identify if the dirt is

on the specimen, microscopy optical system, or in the camera:

1. Dirt on the specimen can be identified by moving the specimen stage. If that is the case, the dirt

will have the same relative movement as the specimen.

2. Dirt on the objective can be identified by comparison with images using a different objective, if

available. If the dirt is on the objective, it will disappear when the objective is changed. Alterna-

tively, dirt on the objective can also be tested by moving the objective slightly and observing if

the dirt also moves or remains stationary.

Note: Remember also that the front of the objective is not in the focal plane and therefore a bit of

dirt on the frontof theobjectivemight appearoutof focus andmay just causeanoverall bad image.

3. If the dirt stays static when the stage moves and is not on the objective, it is probably located in

the optical system, either on the intermediate lens or in the camera sensor, and can be identified

by rotating the camera. If the dirt moves with the camera rotation, the dirt is on the camera. If it

remains stationary, by process of elimination, the dirt is on an intermediate lens. Once the dirt is

found, the following steps need to be taken:

a. Place the objective lens on a dust-free surface.

b. Use an air blower to gently remove the loose dust from the optical glass surface. To avoid

damaging the lens, the air must be blown across the lens surface.

c. Use a cotton swab or a low-lint lens tissue for cleaning optics. Do not rub the lens with dry cotton.

d. To remove water-soluble dirt, dip a cotton swab or lens wipe into distilled water or lens clean-

ing solution, remove the excess liquid, and then wipe the lens in a spiral motion.

e. To remove oily dirt, a lens cleaning liquid or absolute ethanol should be used following the

same procedure as for distilled water. In some cases, the dirt may require several passes to

be completely removed.

CRITICAL: Do not use an excessive amount of liquid. A single drop or immersion of the
cotton swab or lens wipe should be sufficient. Remember to never apply the liquid directly

to the lens.
Calibration of image pixel size

Timing: 10 min

Normally, a microscope with a built-in camera has a scale bar in its system that provides a convertible

value for the image pixels into a known unit, such as micrometers.However, if the camera is added as
2 STAR Protocols 3, 101144, March 18, 2022
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a peripheral, the user needs to find out what a pixel unit corresponds to in the desired unit. One way

to acquire the image pixel size value is by a simple calculation of the ratio between the camera pixel

size and the objective magnification (Equation 1).

Image pixel size =
Camera pixel size

Objective magnification
(Equation 1)
CRITICAL: Each camera has a specific image pixel size. Make sure to obtain the right value
in the camera manual.
The image pixel size value can also be obtained experimentally. Calibration of image pixel size

should be performed by imaging a stage micrometer and calculating the X- and Y-axis pixel size

in ImageJ software (Schneider et al., 2012). If the microscope has built-in calibration, it is recommen-

ded to verify the calibration using the same procedure. For that, a stage micrometer calibration slide

can be used with an image capture program. For ImageJ, follow these steps:

4. Put a stage micrometer on the microscope and acquire the image.

5. Use ImageJ to find the pixel value:

a. Open the image file on ImageJ.

b. On the scale bar, draw a straight line to define a known distance.

c. Go to the menu and select ‘Analyze’ > ’Set Scale’.

d. In the dialog window, type in the ’Known distance’ box, the distance value in micrometers

(from the stage micrometer).

e. The scale will show the relationship between the pixel and micrometers.

f. Use the following formula to find the image pixel size in micrometers:

Image pixel size =
distance

Number of pixels
(Equation 2)
To add the scale bars to the images using ImageJ, please follow the steps below: http://www.

swarthmore.edu/NatSci/nkaplin1/scalebar.htm
Microscope resolution

The microscope resolution defines the sensitivity for measurements of cell contractility. The micro-

scope spatial resolution can be estimated by the formula:

Resolutionx;y =
1:22l

NAobj + NAcon
(Equation 3)

where, l is the imaging wavelength of light, and NAobj and NAcon are the objective and the

condenser numerical aperture, respectively. In our experiments, we used an objective with 403

magnification (NAobj= 0.55) and the LongWorking Distance (LWD) condenser (NAcon = 0.8). Using

an average wavelength for visible light = 0.55 mm, we have:

Resolutionx;y =
1:22 x 0:55

0:55+ 0:8
= � 0:5 mm (Equation 4)

To obtain robust data, the pixel size should be below the microscope resolution. In our setup, the

pixel size was 0.25 mm.
KEY RESOURCES TABLE
REAGENT or RESOURCE SOURCE IDENTIFIER

Chemicals, peptides, and recombinant proteins

Penicillin-Streptomycin Sigma-Aldrich Cat#P4333

NaCl Sigma-Aldrich Cat#746398

(Continued on next page)
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Continued

REAGENT or RESOURCE SOURCE IDENTIFIER

Glucose Sigma-Aldrich Cat#G7528

MgCl2 Sigma-Aldrich Cat# M1028

HEPES Sigma-Aldrich Cat#H3375

Dulbecco’s Modified Eagle’s Medium Sigma-Aldrich Cat#D1152

Absolute ethanol Sigma-Aldrich Cat#24102

Fetal Bovine Serum Thermo Fisher Scientific Cat#16000044

CaCl2 Thermo Fisher Scientific Cat#CX01561

B27 supplement Thermo Fisher Scientific Cat#17504044

RPMI 1640 Thermo Fisher Scientific Cat#11875085

NaH2PO4 Dinâmica Quı́mica LTDA Cat#1160

KCl Vetec Cat#109

Y27632 Cayman Chemical Cat#10005583

Experimental models: Cell lines

Human-induced pluripotent stem cell-derived
cardiomyocytes (hiPSC-CM)

Pluricell Biotech� https://www.pluricellbiotech.com

Experimental models: Organisms/strains

Mouse - C57BL/6J, (Male: 4 weeks and older) Animal Facility UFMG https://www.jax.org/strain/000664

Rat - Wistar (Male: 1–3 days) Animal Facility of the Department of
Physiology and Biophysics ICB-UFMG

N/A

Software and algorithms

CONTRACTIONWAVE executable file Scalzo et al., 2021 https://doi.org/10.1016/j.crmeth.2021.100044

ImageJ Schneider et al., 2012 https://imagej.nih.gov/ij/

PIXCI� V3.8 Software EPIX, Inc. https://www.epixinc.com/support/files.php

Other

CMOS camera EPIX, Inc SILICON VIDEO � 642M

Nikon Eclipse Ti-E inverted microscope Nikon Ti-E

ChamlideIC-CU Incubator Live Cell Instrument,
Nowan-gu, Korea

109

Square Pulse Stimulator Grass Instruments SD9

Platinum electrodes N/A N/A

Stericup-GP Sterile Vacuum
Filtration System 0.22 mm

Millipore SCGPU11RE

ZEISS Lens Cleaning KIT (Air blower,
dust brush, lens cleaning solution (30 ml),
microfibre cloth (18 x 8 cm),
10 moist cleaning wipes)

Zeiss N/A

Lens Wipes Zeiss N/A

1 mm Stage Micrometer with 10 mm Divisions Thorlabs R1L3S2P

CPU - Intel Celeron 800 MHz
(Intel Core 2 Duo 2 GHz – RAM 4GB - HD 500GB)

N/A N/A

CPU Monitor 19" N/A N/A
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MATERIALS AND EQUIPMENT

To perform this protocol, the following technical equipment are necessary:

CCPU, monitor, a microscope and a high-speed digital camera with software for image acquisition.

CAmini incubator coupled to amicroscope stage is necessary for experiments that require temper-

ature and/or CO2 control.

C Lens cleaning kit (if required).

C Stage micrometer (if required).

C Square Pulse Stimulator and platinum electrodes for adult-CM stimulation.
4 STAR Protocols 3, 101144, March 18, 2022
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Tyrode’s solution for adult-CM

Reagent Final concentration (mmol/L) Amount

NaCl 140 818.1 mg

KCl 5 37.27 mg

Glucose 10 180.1 mg

HEPES 5 119.1 mg

CaCl2 1.8 20 mg

NaH2PO4 0.4 4.8 mg

MgCl2 solution (1 mol/L) 1 0.1 mL

NaOH (5 mol/L) – pH adjustment

Milli-Q water – Up to 100 mL

Total – 100 mL

ll
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Add constituents above to 90mLMilli-Q grade water. Adjust the pH with NaOH to 7.4 and complete

the volume to 100 mL. Keep the solution at room temperature for use on the same day.

CRITICAL: Warm up the solution in a water bath according to the desired experimental
temperature condition.
Different types of experiments may require a specific solution.
Dulbecco’s modified Eagle’s medium for neonatal-CM

Reagent Final concentration Amount

Dulbecco’s Modified Eagle’s Medium – 4.5 g

Penicillin-Streptomycin 100 U/mL–100 mg/mL 10 mL

NaOH (5 mol/L) – pH adjustment

Milli-Q water – Up to 1000 mL

Total n/a 1000 mL

Fetal Bovine Serum 10% 100 mL
Add the medium and Penicillin-Streptomycin to 950 mL Milli-Q grade water. Adjust the pH with

NaOH to 7.4, and complete the volume to 1000 mL. Filter the solution with a 0.2 mm filter/vacuum

for sterilization. Add the Fetal Bovine Serum. This step has to be performed with sterile material in a

laminar flow cabinet.

Store at 4�C for up to 1 month.

CRITICAL: Warm up the solution in a water bath according to the desired experimental
temperature condition. Different types of experiments may require a specific culture

medium.
RPMI 1640 medium for hiPSC-CMs

Reagent Final concentration Amount

RPMI 1640 n/a 97.99 mL

Y27632 (0.1 mol/L) 10 mmol/L 0.01 mL

B27 supplement 2% 2 mL
These steps have to be performed with sterile materials in a laminar flow cabinet.

Store the medium at 4�C for up to 1 week.

Total n/a 100 mL
STAR Protocols 3, 101144, March 18, 2022 5



Tab

Par

Mic

Ob

Mic

Me

Min

Cam

Rec

Cam

Ima

Win

ll
OPEN ACCESS

6

Protocol
CRITICAL: Warm up the solution in a water bath according to the desired experimental
temperature condition. Different types of experiments may require a specific culture

medium.
STEP-BY-STEP METHOD DETAILS

Microscope and image setting for the different cell types

Timing: 5–10 min

To perform cellular contractility experiments, a standardmicroscope coupled with a digital camera is

necessary. The microscope contrast needs to be sufficient to identify the cellular membrane. Impor-

tantly, the magnification must allow the user to visualize the whole cell, typically requiring between

203–403magnification with a pixel size of 0.2–0.5 mm. In order to capture a high-quality image and

fully detect the entire cell movement, both microscope resolution and image pixel size should be

smaller than the sarcomere length, which is around 1.8 mm (Li et al., 2016; Pollack and Huntsman,

1974). Due to differences in cell contractility speed within the different cell types, a camera should

have a frame rate ranging from 25 to 200 fps (see Table 1 for details).

Different cell types may require specific microscope settings, and to achieve the best contrast, some

adjustments to diaphragm aperture, focus, and light intensity may be necessary. The mature sarco-

mere structure found in adult cardiomyocytes provides robust contrast for contraction measure-

ments. In comparison, neonatal-CMs and hiPSC-CMs have intrinsically lower contrast due to the

absence of an organized sarcomere structure and lack of a t-tubule system (Bedada et al., 2016;

Khan et al., 2015; Li et al., 2017). In addition, contractility can be significantly affected by differences

in cardiomyocyte structural maturity. Neonatal-CMs and hiPSC-CMs not only have weaker contrac-

tion compared to adult-CMs, but their syncytium self-organization can also contract spontaneously

(Bedada et al., 2016; Bezzerides et al., 2019; Li et al., 2017). These characteristics require slightly

different microscope settings between these types of cells.

CRITICAL: An inappropriate microscope setting will directly influence the acquisition of
contractility that is obtained through cell membrane movement, reflecting in a poor mea-

surement of the contractility parameters.
1. Focus: the focus should be adjusted until the cell border is delimited with minimum edge bright-

ness (see Focus on Figures 1, 2, and 3). Small adjustments should be made to the fine focus con-

trol until the cell border is sharp and without any optical bloom.

Note: For adult-CMs, the focus should be optimized to obtain the greatest amount of black

and white variation longitudinally, providing a clear visualization of sarcomere striations

(see Focus on Figure 1A). For neonatal-CM or hiPSC-CM, intracellular vesicles or cell nuclei
le 1. Contractility recording settings

ameters Adult-CM Neonatal-CM hiPSC-CM

roscope setting

jective magnification 403 203–403 203–403

roscope diaphragm aperture (%) 30 30 30

an gray value (8-bit image) �127 �127 �127

imum microscope resolution � 0.5 mm � 0.5 mm � 0.5 mm

era settings

ording speed (fps) 200 25–100 25–100

era suggestion CMOS CMOS CMOS

ge Type 8-bit 8-bit 8-bit

dow size (px) 640 3 200 640 3 480 640 3 480

STAR Protocols 3, 101144, March 18, 2022



Figure 1. Optimal brightfield microscope settings for adult-CMs

(A) Focus: Out-of-focus cells present a bright halo around the cell border and poor resolution of intracellular

structures. Use the fine focus control to minimize border brightness and to bring intracellular structures into sharp

focus. Diaphragm: changes in the diaphragm drastically alter cell visualization. A fully-opened diaphragm (100%)

results in low contrast whereas a closed-down diaphragm (10%) produces sufficient contrast but an overall-all dark

image. Mean gray value (MGV): Lighting and camera settings should be adjusted so that the gray value histogram is

centered on the half-maximal range (127 for an 8-bit image), with no pixel intensities close to zero or to saturation.

Ideal settings are highlighted in the red rectangle.

(B) Gray value histogram acquired for each condition presented in (A). For greater precision, the variation of

illumination should be observed from the gray value histogram, generated by the camera’s application program or

the image can be processed by ImageJ software.
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can be used as a reference to find the best focus. Well-focused vesicles usually will have a

black interior and both vesicles and nuclei should have a well-defined border (see Focus on

Figures 2A and 3A).

2. Diaphragm aperture (Condenser lens): Start with the microscope setup for Kohler illumination.

Open the diaphragm fully, which results in a cell image with low contrast and with little cell border

delineation (see panel Diaphragm 100% in Figures 1A, 2A, and 3A). Slowly close the diaphragm

until the delineation of the cell edge and nucleus appear and contrast is optimized.

Note: For adult-CMs, good contrast can generally be obtained with the diaphragm 20%–30%

open (see Diaphragm 30% Figure 1A), and for neonatal-CM or hiPSC-CM, 30% (see Dia-

phragm 30% Figure 3A).

3. Mean gray value (MGV): Pixel brightness is converted into a grayscale value that is the primary

information in an image. Usually, an 8-bit image is sufficient to acquire the cell contractility pa-

rameters. This kind of image has a grayscale that ranges from 0 to 255, and the ideal illumination

intensity will nearly fill this range, leaving a margin of error to guarantee that no pixels go below

camera sensitivity or above saturation. Thus, the best approach is to adjust lighting and camera
STAR Protocols 3, 101144, March 18, 2022 7



Figure 2. Optimal brightfield microscope settings for neonatal-CMs

(A) Focus: Out-of-focus cells present a bright halo around the cell border and poor resolution of intracellular structures. Use

the fine focus control tominimize border brightness and to bring intracellular structures into sharp focus. Diaphragm: changes

in the diaphragm drastically alter cell visualization, when it is fully open (100%) the cell does not have a clear delimitation and

contrast. When it is partially 10% opened the cell has a dark border, indicating poor lighting of the cell. Therefore, normally in

a brightfield microscope, the diaphragm should be 30% opened to get the best contrast. Mean gray value (MGV): In an 8-bit

image, the best illumination will be proportional to the average total pixels of the image, which in this case will be 127. Smaller

values do not produce good lighting, and larger values produce an excess of illumination and can reach exaggerated pixel

intensity. Ideal settings are highlighted in the red rectangle.

(B) Gray value histogram acquired for each condition presented in (A). For greater precision, the variation of

illumination should be observed from the gray value histogram, generated by the camera’s own application program

or the image can be processed by the ImageJ software.
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settings to set the background close to 127, which is the middle of this range. This procedure can

be carried out using a grayscale value histogram plot (Figures 1B, 2B, and 3B).

Note: The histogram plot can be usually acquired in real time through the software camera

acquisition, or the image can be captured, stored, and processed by ImageJ software

(‘Analyze’> ‘Histogram’ or Ctrl + h).

CRITICAL: Make sure that the combination of these steps (focus, diaphragm and mean
gray value) leads to the best contrast image.
Camera setting and image collection for the different cell types

Timing: 5 min
8 STAR Protocols 3, 101144, March 18, 2022



Figure 3. Optimal brightfield microscope settings for hiPSC-CMs

(A) Focus: Out-of-focus cells present a bright halo around the cell border and poor resolution of intracellular

structures. Use the fine focus control to minimize border brightness and to bring intracellular structures into sharp

focus. Diaphragm: changes in the diaphragm drastically alter cell visualization, when it is fully open (100%) the cell

does not have a clear delimitation and contrast. When it is 10% opened the cell has a dark border, indicating poor

lighting of the cell. Therefore, normally in a brightfield microscope, the diaphragm should be 30% opened to get the

best contrast. Mean gray value (MGV): In an 8-bit image, the best illumination will be proportional to the average total

pixels of the image, which in this case will be 127. Smaller values do not produce good lighting, and larger values

produce an excess of illumination and can reach exaggerated pixel intensity. Ideal settings are highlighted in the red

rectangle.

(B) Gray value histogram acquired for each condition presented in (A). For greater precision, the variation of

illumination should be observed from the gray value histogram, generated by the camera’s own application program

or the image can be processed by the ImageJ software.
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The first step to cell imaging acquisition is to set up the camera for image collection. Importantly,

different cell types require specific parameters, such as image size and capture rate, and they

must be set before starting the experiment.

In the camera software:

4. Select the image window size to record just the area of interest around the cell. For adult-

CMs experiments, using the magnification (403) and pixel size (0.25 mm/pixel) of our

microscope (see Microscope resolution), an image window size of 640 horizontal 3200 vertical

pixels allows most cells to fit within the image. Neonatal-CM or and hiPSC-CM require a field of

view, and an image window size of 640 3 480 pixels is our standard configuration for these

cells.
STAR Protocols 3, 101144, March 18, 2022 9
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Note: If in the experiment more than 5% of the adult-CMs does not fit within the image win-

dow, increase the height or width window size. For many cameras, variation of the window

height does not affect the maximum frame rate that can be acquired, which is limited by

the window width. Therefore, it is easier to change the height size to find the best window size.

CRITICAL: The resolution window size must be the same within and across experimental
groups to provide the best comparison.
5. Background correction

To acquire a clearer image without background interference, we recommend the use of background

correction (for details, see Troubleshooting - problem 1).

6. Select the capture frame rate

The capture frame rate is an important parameter to acquire a complete and robust contraction-

relaxation cycle wave. To do so, it is important to keep in mind that mature cells have a greater

contraction speed and contraction area compared to immature cells, and therefore, require higher

frame rates. To find the best rate, note that the minimum acquisition period to reliably reconstruct

a signal needs to be smaller than half the time of the fastest component (Nyquist, 1928). For more

details see Scalzo et al. (2021) (User Manual provided as Methods S1, section 2.2 Requirements,

subsection: Minimum frame rate).

Note: The frame rate and the intrinsic noise produced by the cell movement can influence the

way the data is visualized (for more details, see Troubleshooting - problem 2).

7. Save images

The camera should be connected to the computer through a USB 3.0 interface, to provide high

frame rate acquisition. Most of the camera software allows capturing and storing the image in

different ways. The best way to avoid variation in the capture rate value is to choose the option

that first stores the images in the RAM, and then the user saves manually in computer HD.

CRITICAL: Make sure that throughout image acquisition the capture rate remains at the
desired speed during all the capture time. Sometimes, there is a slight variation in the cam-

era capture rate. Be aware that the variation must not exceed 1% of the desired value.
Contractility assay in cardiomyocytes

Adult-CM experiments

Timing: 1–4 h

The adult-CM usually has a robust contraction and a good cell image contrast (Methods video S1),

allowing an easier image acquisition compared to more immature neonatal cells (Methods video S2)

and hiPSC-CMs (Methods video S3). However, since healthy adult-CM require electrical stimulation

to contract, and exhibit a higher degree of heterogeneity compared to immature cells, some steps

are essential to acquire the contraction properly:

8. Assemble the cell-stimulation chamber and fix it onto the stage of the microscope.

Note: In our cellular contractility experiments, isolated adult-CMs must be plated on a suitable

chamber. Our laboratory utilizes a commercial chamber (model ChamlideIC-CU: 109, Live Cell

Instrument, Nowan-gu, Korea) (see key resources table). However, any mini-incubator with
STAR Protocols 3, 101144, March 18, 2022



ll
OPEN ACCESSProtocol
temperature and CO2 control (when required) should work. Usually, the chamber can be

attached to the microscope through a specific stage provided with the incubation system.

9. Set the temperature to 37�C. Position the recording chamber and platinum electrodes that will

provide the field stimulation to generate the cell action potential.

10. Turn on the stimulator and set up the parameters (frequency, voltage, and pulse width duration).

11. Resuspend the dissociated adult-CM in the Tyrode solution.

Note:High cellular density can impair single cell visualization, so dilution is recommended (for

more details, see Troubleshooting - problem 3).

12. Gently homogenize the cell solution and add a few drops of cells in the chamber at 37�C until the

experiment starts. Wait at least 1 min for the cells to settle. Usually, the cells attach to the surface

without any coated substrates. However, different types of experiments may require the surface

to be coated with laminin or another matrix solution (e.g., cell perfusion experiments).

13. Select a healthy cardiomyocyte, position the cell in the center of the field of view, and rotate the

camera as necessary to align the long axis of the cell with the horizontal axis of the image win-

dow. To distinguish between healthy and unhealthy cells, please see Troubleshooting - problem

4. Due to the strength of their contractions, adult-CMs can occasionally detach from the surface,

changing the alignment. However, even in this case, the analysis can be performed provided

that no part of the cell leaves the image field of view.

14. Adjust the adult-CM image focus as described in the ‘‘microscope and image setting for the

different cell types’’ section.

15. Start the camera recorder.

16. Turn on the stimulator. Choose the pacing condition which will depend on the experiment goal.

17. Acquire cell contractility.

For a healthy control cardiomyocyte, starting with the cell at rest, the first contraction will be the

strongest one, as the sarcoplasmic reticulum calcium store is full. As the stimulation sequence pro-

ceeds, there is a decay in the cell shortening of each subsequent contraction through calcium ho-

meostasis. Control cells generally reach a steady state after 10–15 contractions, although this can

vary from animal to animal and experimental conditions, such as the temperature setting. After

the cell contraction amplitude reaches steady-state, record relevant contractility data.

CRITICAL: In healthy cardiomyocytes, the cells must contract in synchrony with the stim-
ulation. Moreover, before electrical pacing begins, the cells should be quiescent. Cells that

contract in the absence of stimulation or that present arrhythmic events (Methods videos

S4 and S5) should be excluded from the analysis.
Note: To obtain the CM fractional shortening, the cell border must be well defined.

Neonatal-CM and hiPSC-CM experiments

Timing: 1–4 h

Make a preparation of neonatal-CM or hiPSC-CM that has several separated syncytium and sponta-

neously contracting cells.

CRITICAL: A culture that has not formed a connection between cells to form a syncytium
usually does not contract, or if it does, shows a lower contraction area.
18. Turn on the chamber at 37�C and 5% CO2.

19. Put the recipient containing the culture cells in the microscope chamber.
STAR Protocols 3, 101144, March 18, 2022 11
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CRITICAL: The temperature and the culture medium can strongly impact cardiomyocyte
contractility. Hence, subtle variations in these parameters can drastically alter cellular

contractility results. In our experiment, we use Dulbecco’s modified Eagle’s culture medium

(DMEM) supplemented with 10% fetal bovine serum (FBS) for neonatal-CM and RPMI 1640

supplementedwith 10 mMof Y27632 for hiPSC-CM (formore details, see key resources table

and Materials and equipment). However, different types of experiments may require a spe-

cific culture medium. Wait at least 5 min to stabilize the cell temperature at 37�C.
20. Select the cell in the region of interest (ROI) in the camera image field according to the steps

described in the ‘‘microscope and image setting for the different cell types’’ section.

Note: It is recommended to acquire the data in a syncytium where all cell contractions are syn-

chronized and that have similar areas and number of cells (that can be estimated by counting

cell nuclei). Images of multiple syncytia or an unsynchronized syncytium will not show a typical

signal to be analyzed. In neonatal-CM culture select the cell area without debris or fibroblasts

(for details see Troubleshooting - problem 5).

Importantly, the size of the pre-set window should be adjusted accordingly and be kept the same

throughout the entire experiment. If the syncytium is too big and does not fit in the image, a tip is

to look for and acquire the contraction at its center of convergence. Acquire the cell contractility

for at least 15 s.

Saving images

Images should be saved at a depth of at least 8-bit. There are three standard ways to store contrac-

tility images:

Image sequence: a folder containing multiple images in sequence.

Multipage image: one TIFF file.

Video file data: one video with .avi extension.

It is recommended that images are saved using the TIFF file format. Many other common image for-

mats, such as JPEG, use image compression resulting in loss of information. However, if HD space

limitations require the use of compressed file formats, it is important to be aware of the possibility of

information loss and to consistently use the same file format in all experimental groups that will be

compared.

Contractility analysis using CONTRACTIONWAVE

Once high-quality data is acquired, the analysis of contractility parameters can be performed using a

variety of available software programs (IonWizard Ionoptix; Boudaoud et al., 2014; Grune et al.,

2019; Maddah et al., 2015; Pasqualin et al., 2016; Sala et al., 2018). The authors have developed

CONTRACTIONWAVE (Scalzo et al., 2021), a high-performance Python program that processes

video micrograph films using dense optical flow image analysis. This program has been validated

for large-scale analysis of different cell types (adult-, neonatal- and hiPSC-CMs), treated or not

with drugs, including both healthy cells and cells isolated from animal models of human disease. Fig-

ure 4 illustrates the CONTRACTIONWAVE window that shows the average speed of contraction-

relaxation cycle results of an adult-CM that was electrically stimulated at 1 Hz and processed using

the software.

In the wave detection window, a time interval can be selected by the user (top panel, orange area,

Figure 4A). Once an interval is chosen, the program displays a zoomed plot of the selection in the

window below (bottom panel, Figure 4A). An innovative feature of CONTRACTIONWAVE compared
STAR Protocols 3, 101144, March 18, 2022



Figure 4. Analysis of cellular contractility using CONTRACTIONWAVE

(A) CONTRACTIONWAVE data analysis window allows interval selections of the contraction-relaxation waves. The

software automatically detects the average speed of the contraction-relaxation waves and allows for fine adjustments

to improve peak detections (top panel). To assist single or multiple peak selection for data analysis, a zoomed version

of the selected interval is displayed on the panel below (bottom panel).

(B) CONTRACTIONWAVE simultaneously displays both the cell image (top panel) and the contraction-relaxation waves

(bottom panel). The top panel shows the cardiomyocyte image with the magnitude and motions vectors of the contractility

movement acquired during step (2) represented on the bottom panel (the orange area highlights the time in which the upper

cell image was acquired). Note that the average speed corresponds to a single contraction-relaxation cycle of an electrically

stimulated cardiomyocyte. Colored circles presented in the contraction-relaxation wave (bottom panel) represent (1)

contraction initiation; (2) maximum contraction speed (MCS); (3) minimum contraction speed; (4) maximum relaxation speed

(MRS); (5) return to baseline. Figure adapted from Scalzo et al. (2021)
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to other available software is its ability to display simultaneous views of the cell image and the

derived contraction-relaxation wave (Figure 4B). Contractility analysis using CONTRACTIONWAVE

allows for the acquisition of three distinct types of parameters of the contraction-relaxation cycle:

speed of contraction at different points along the cycle, time intervals between several important

phases of contraction-relaxation cycle, and shortening area, in appropriate calibrated units. For a
STAR Protocols 3, 101144, March 18, 2022 13
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complete description and definition of all contractility parameters, please see Figure 3 in the original

description of CONTRACTIONWAVE (Scalzo et al., 2021).

Note: CONTRACTIONWAVE is open-source software and all details for download, installa-

tion, and optimized use are fully described in Scalzo et al. (2021).

EXPECTED OUTCOMES

On a successful acquisition of cellular contractility, CONTRACTIONWAVE will properly detect the

contraction-relaxation cycle through the dense optical flow. The software can obtain the magnitude

and vector field of the membrane movement (Figures 5A, 6A, and 7A show only the maximum

contraction speeds), and their respective cycle graphs (Figures 5B, 6B, and 7B), to analyze the
Figure 5. Sub-optimal microscope settings for image acquisition of adult-CMs can impact contraction-relaxation average speed

(A–E) Representative image of magnitude and vector field from the maximum contraction speed, and (B) the respective cell contraction-relaxation cycle

processed by CONTRACTIONWAVE using the optimal acquisition parameters (Cell in focus; Diaphragm = 30% and MGV = 127). Sub-optimal microscope

settings such as poor focus (C), improper diaphragmopening (D), or lowmean gray values (MGV) (E) could result in an underestimate of the contraction-relaxation

speed. Below each graph is a representative image of magnitude and vector field from the maximum contraction speed acquired in a specific setting.
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Figure 6. Sub-optimal microscope settings for image acquisition of neonatal-CMs can impact contraction-relaxation average speed

(A–E) Representative image of magnitude and vector field from the maximum contraction speed, and (B) the respective cell contraction-relaxation cycle

processed by CONTRACTIONWAVE using the optimal acquisition parameters (Cell on Focus; Diaphragma = 30% opened and MGV = 127). Sub-

optimal microscope settings such as poor focus (C), improper diaphragm opening (D), or low mean gray values (MGV) (E) could result in an

underestimate of the contraction-relaxation speed. Below each graph is a representative image of magnitude and vector field from the maximum

contraction speed acquired under a specific setting.
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contractility parameters. In order to demonstrate how the microscope settings can influence data

acquisition, contraction-relaxation data were acquired and analyzed for different settings (Figures

5C–5E, 6C–6E, and 7C–7E)
STAR Protocols 3, 101144, March 18, 2022 15



Figure 7. Sub-optimal microscope settings for image acquisition of hiPSC-CMs can impact contraction-relaxation average speed

(A–E) Representative image of magnitude and vector field from the maximum contraction speed, and (B) the respective cell contraction-relaxation cycle

processed by CONTRACTIONWAVE using the optimal acquisition parameters (Cell on Focus; Diaphragma = 30% opened and MGV = 127). Sub-

optimal microscope settings such as poor focus (C), improper diaphragm opening (D), or low mean gray values (MGV) (E) could result in an

underestimate of the contraction-relaxation speed. Below each graph is a representative image of magnitude and vector field from the maximum

contraction speed acquired under a specific setting.
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All three parameters analyzed (focus, diaphragm, and MGV) showed an influence in the contraction-

relaxation speed in the three cell types (Figures 5, 6, and 7). It is interesting to note that the contrac-

tility wave of cardiac cells is influenced by the focus. In the example shown in Figures 5C and 6C, the
16 STAR Protocols 3, 101144, March 18, 2022
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contraction-relaxation speed is greatly altered when the focus is below -5 mm for adult-CM and at or

above +10 mm for neonatal-CM compared to the focused image. Measurement of contraction-relax-

ation speed of hiPSC-CM is significantly influenced by the quality of focus (Figure 7C), partly due to

lower contrast and cell thickness. Of note, the optimal focus value may need to be adjusted for each

cell.

The diaphragm is a vital microscope component when ensuring image quality for contractility analysis.

With diaphragm values higher than 40%opened, the cell contrast is not properly obtained, significantly

influencing the contraction-relaxation waves (Figures 5D, 6D, and 7D). Although diaphragm settings

can influence the movement detection for all cell types, it is important to point out that hiPSC-CM cells

are the most influenced by this type of setting. Diaphragm aperture higher than 40%will not allow for a

proper detection of the coordinated movements to generate a typical wave of hiPSC-CMs (Figure 7D).

Mean gray values (MGV) of 50 and lower show a decrease in the contraction-relaxation speed (Figures

5E, 6E, and 7E). This is probably due to the fact that the camera loses information from small gray level

values. Therefore, for an 8-bit image, MGV should be set to the middle of the camera’s dynamic range,

close to 127. For data analysis using CONTRACTIONWAVE, the brightness does not significantly affect

the contraction-relaxation results. With this said, good results can be achieved with an illumination that

provides sufficient light to visualize the cell with no difficulty. This value should be higher than 100MGV

to avoid the camera’s influence.

In summary, all these parameters will influence the final contraction-relaxation speed, since they pro-

vide a variation in the detection sensitivity of the magnitude and motion vectors of the cell mem-

brane (see sample images provided below panels C-E in Figures 5, 6 and 7). See Table 1 for a sum-

mary of all contractility recording settings.

LIMITATIONS

A high-quality cardiomyocyte contractility analysis is largely dependent on the condition of the iso-

lated cells and how they were prepared. For instance, adult-CM samples with a large number of

dead cells or inadequate morphology (see Troubleshooting - problem 4) will not provide robust

contractility data. The small shortening area of neonatal-CM and hiPSC-CM can also impact contrac-

tility data acquisition. For instance, more subtle contractions can sometimes be interpreted as noise,

and because of that, they cannot be measured (see Scalzo et al., 2021).

TROUBLESHOOTING

Problem 1: Background correction for non-uniformity of illumination

Non-uniform illumination in a brightfield imaging experiment does not significantly impact cellular

contractility analysis using CONTRACTIONWAVE. Nonetheless, it can affect the image background

(Figure 8), and the user may choose to correct it.

Some camera software allows the user to automatically set up the background correction during the

recording step. When that option is not available, the background correction can also be done after

images are acquired (see potential solution below).

Potential solution 1

A standard way of doing the background correction after data acquisition is by using the ImageJ

software (download and installation instructions: https://imagej.nih.gov/ij/ or https://fiji.sc/). First,

an image of the empty chamber without the cell is acquired to show the non-uniform illumination

of the background in a brightfield image (Figure 8i). The correction consists in dividing the cell image

by the background image and multiplying the result by the average value of the original image

(Equation 5).

Background correction =
Cell image sequence

Image background
3Background mean gray value (Equation 5)
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Figure 8. Background correction for non-uniformity of illumination using ImageJ

i. Import one ‘‘background-image’’ taken on a surface with no cell and ii. Obtain the background mean gray value (red square value). iii. Open the cell

‘‘image sequence’’. iv. Select Image 1 with the ‘‘image sequence stack’’, Operation ‘‘Divide’’ and Image 2 with the ‘‘background-image’’. Click the boxes

‘‘Create a new window’’ and ‘‘32-bit (float) result, then click ‘‘OK’’ and select ‘‘Yes’’ to process all images. v. Go to Edit > Options > Conversions to make

sure no option is selected. Multiply the resulting image (vi) by the background mean gray value obtained in step ii as shown in step vii. A white image will

appear (viii). ix. Convert the 32-bit image (viii) into 8-bit and save the correction image.
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The steps to process the background correction using ImageJ goes as follows:

a. In ImageJ software, import the ‘‘background-image’’ (captured from a surface with no cell, Fig-

ure 8i) and go to Analyze > Measure, to obtain the background mean gray value parameter

(Figure 8ii).

b. Select File > Import > Image Sequence to open the ‘‘Image sequence’’ (Figure 8iii).

c. Go to Process > Image Calculator and select the previous imported ‘‘Image sequence’’ (in Image

1), ‘‘Divide’’ (in operation), and ‘‘background-image’’ (in image 2) (Figure 8iv). Click ‘‘Create a new

window’’ and ‘‘32-bit (float) result’’, and then hit the ‘‘OK’’ button and select ‘‘Yes’’ to process all

images.

Go to Edit > Options > Conversions to make sure no option is selected in the window (Figure 8v).

d. In the resulting image (Figure 8vi) go to Process > Math > Multiply and put the background mean

gray value (Figure 8vii), which was obtained in Figure 8ii. A white image will appear (Figure 8viii), rep-

resenting the brightness adjustment. Then, go to Image > Type > 8-bit to convert the 32-bit image

into 8-bit.

e. The new window will automatically show the converted final image with the corrected background

(Figure 8ix).

f. Save image as multipageTIFF (File > Save as > TIFF), or as image sequence (File > Save as > Image

Sequence).

Note: To resolve other background problems such as hot pixels and banding, please see the

following ImageJ tutorial at: https://imagejdocu.tudor.lu/howto/working/how_to_correct_

background_illumination_in_brightfield_microscopy
Problem 2: Noisy contractility data

Commonly, contraction-relaxation recordings from immature cells have a lower signal-to-noise ratio

compared to recordings from adult cardiomyocytes. In particular, neonatal-CMs and hiPSC-CMs

often show an increased signal noise during the relaxation phase (Figures 9A and 9B). For these

cellular types, it is important to minimize the noise to obtain a reliable and robust contractility

analysis.
Potential solution 2: Change the capture rate or apply a filter

The image capture rate can influence the signal noise. Essentially, the higher the capture rate, the

shorter the displacement collected for each pixel between two frames. A short cell displacement

can result in a calculated speed that is close to the limit of detection, increasing the amount of

captured noise. Adjustments in the frame rate can be made to minimize this effect. Reducing

the frame rate to an optimal value can significantly reduce noise with little or no impact on the

derived contraction-relaxation wave parameters (maximum contraction speed (MCS) and

maximum relaxation speed (MRS)). Our experiments demonstrate that hiPSC-CMs have a low

average speed (<10 mm/s) and a cell recording performed at 100 fps captures noisy data that is

difficult to analyze (Figure 9A). By simply reducing the camera frame rate, the noise gradually de-

creases, while the contractility speed parameters are maintained (Figures 9B and 9C). Importantly,

an excessive frame rate decrease can directly impact the MCS and MRS parameters (Figures 9D

and 9E), so a careful calibration analysis must be done to identify the optimal frame rate value

for the specific cell type.
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Figure 9. Reducing noise by adjusting frame rate and using filters

(A and B) Contraction-relaxation data acquired at 100 and 50 frames per second (fps) from hiPSC-CM show a high

noise content that can contribute to errors in the data analysis.

(C) Contraction-relaxation data acquired at 25 fps shows an optimal balance between noise minimization and data

integrity.

(D and E) Contraction-relaxation data acquired at 12 and 6 fps show significant reductions in the signal noise, but

significantly affect maximum contraction speed (MCS) and maximum relaxation speed (MRS).

(F) Contraction-relaxation data acquired at 100 fps and analyzed using the denoising filter provided by

CONTRACTIONWAVE shows significant reductions in the signal noise, not compromising MCS and MRS values.
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Alternatively, CONTRACTIONWAVE provides denoising filters that can also minimize the influence

of background noise, with no requirement of a specific frame rate (Figure 9F). All details for filter use

can be found in Scalzo et al. (2021) (Method S1- User Manual).
Problem 3: Adult-CM cellular density for image acquisition

When acquiring adult-CM contractility data, it is important that there be only a single cell in the field

of view, as the presence of neighboring cells can impact the results. Thus, the density of dissociated

cells in the suspension is a key parameter for clear cell image acquisition.
Potential solution 3

The cell image should be as clean as possible. For this, be careful with the adult-CM final cell density.

The best way to obtain a clean image is by adjusting the volume that is plated so that the settled cells

will have a confluence of about 40%. The greater the confluence, the more nearby cells will be ac-

quired in the same image window, and the more difficult it will be to acquire a single-cell image.

This type of dilution will also decrease the amount of cell debris and dirt that may remain throughout

the solution.
Problem 4: Adult-CM cell variability

When choosing an adult-CM cell to acquire the image data, be aware that bubbles and cell debris

can dramatically impact the contractility results. It is very important to identify these undesirable

components to guarantee that the best cell image will be captured and then analyzed. In addition,

the shape of the cell can help identify healthy cardiomyocytes (see details below).
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Potential solution 4

Bubbles or cell debris that enters the field of view can be observed directly or by the shadow they

cast. If this happens, stop recording since their presence will cause the analysis to underestimate

contraction speed. The experiment can be restarted after clearing the bubbles or debris. When add-

ing the cell solution, avoid generating bubbles by the pipette, since during the experiment they can

burst, provoking spontaneous contraction.

To obtain the best contraction-relaxation data, it is necessary to be aware of the cell viability,

contraction pattern, and cell morphology. A good adult-CM preparation usually has at least 60%

viable cells. To ensure that quality data is acquired, rod-shaped cells with a clear striation pattern

and well-defined edges should be selected (Figure 10Ai). Make sure not to record from cells with

‘‘cauliflower’’-shaped ends, unclear striation patterns, or contaminated with debris or dead cells

(Figure 10Aii-iv). Blebs on the cell membrane are an indication that the cells are unhealthy (Fig-

ure 10Bi). Another issue is that cells may settle to the chamber resting on their narrow edge rather

than resting flat (Figure 10Bii). These cells should be avoided, as they may impact data analysis by

CONTRACTIONWAVE, as the software analyzes cellular contractility throughout the entire cell

membrane.
Figure 10. Cell selection is an important step to get the best contractility results

(A) Ai. Healthy cells are rod-shaped and have a well-defined border and linear sarcomere striations. Aii. Cells with

cauliflower-shaped ends should not be used to study contractility as they are likely in the process of cell death. Aiii.

The unclear striation pattern will affect the potency of cell contraction-relaxation, therefore should also be avoided.

Aiv. Dead cells are easy to identify, having a more rounded shape and little or no contraction-relaxation.

(B) Bi. Membrane blebs can be an indication of apoptosis and cell damage. Bii. Cells can sediment and be attached to

the substrate on their thin edge, rather than laying flat. Biii. Clusters of two or more cells either on top of each other

(Biii - top) or beside each other (Biii - below) should be avoided.
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Adult cardiomyocytes from healthy animals should not present spontaneous contraction. In this

case, cells that do present spontaneous contraction should be avoided. However, for some disease

models or drug treatments, spontaneous or lack of contractions can occur.

CRITICAL: Sometimes one cell may lie on top of another (Figure 10Biii). Analyzing the cell
border or through stimulation, it is possible to identify the two cells. If the cell clings to

another cell or to debris, the contractility acquisition will be underestimated. In cells

from normal healthy animals, thinner cells must be examined carefully to be sure that

they are not cells that settled on its side.
Problem 5: Neonatal-CM and hiPSC-CM cell variations

Obtaining a good image of the cell syncytium for neonatal-CMs and hiPSC-CMs is crucial to pro-

vide high-quality data of cell contractility. The number of cells, presence of cell debris, and fibro-

blasts must be carefully analyzed before choosing the best cell area to perform the experiment

(Figure 11).
Potential solution 5

Cell debris and dead cells are commonly found in neonatal-CM cultures, usually due to cells that

did not attach to the plate or problems with the dissociation process (Figure 11A). Always try to

acquire an image with the least amount of debris overlaying the cells. Normally, the amount

of debris in hiPSC-CM is much lower. Additionally, caution should be taken with contamination

by fibroblasts in the neonatal-CM culture, as they can indirectly influence cardiomyocyte cont-

ractility through chemical signaling or even physically preventing cardiomyocytes from contracting

properly.

Note: Fibroblasts have a more transparent appearance with a trapezoidal shape, pre-

senting a larger area and nucleus compared to cardiomyocytes, and do not contract

(Figure 11B).
Figure 11. Cell debris and fibroblasts could impact cell membrane movement and influence the contractility results

(A) Ai. The image labeled ‘‘high’’ is an example of preparation with a large amount of dead rounded cells loosely

tethered above the viable stellate cells fixed to the substrate. Aii. The image labeled ‘‘reasonable’’ shows somewhat

less debris. Aiii. The image labeled ‘‘Low’’ is an example of preparation with very little debris, a situation that is ideal

for contractility acquisition. Aiv. Red circles identify the cell nucleus (outlined in red) of the images that contain low cell

debris.

(B) Example of a culture contaminated by a large fibroblast (outlined in red in the right-hand image).
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RESOURCE AVAILABILITY

Lead contact

Further information and requests for resources and reagents should be directed to and will be ful-

filled by the lead contacts, Prof. Silvia Guatimosim (guatimosim@icb.ufmg.br) and Prof. Ubirajara

Aguero (bira@fisica.ufmg.br)

Materials availability

This study did not generate new materials.

Data and code availability

This study did not generate new data and code.

SUPPLEMENTAL INFORMATION

Supplemental information can be found online at https://doi.org/10.1016/j.xpro.2022.101144.
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